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Introduzione
  Simboli e convenzioni

Indica che la mancata esecuzione di un'operazione consigliata potrebbe causare danni alla 
stampante.

Un'informazione che puntualizza o integra determinati passaggi del testo principale.

 

 Avanzato (Advanced) > Regola (Fit):

Testo che compare nell'interfaccia di Badge Studio e su cui è possibile cliccare.

Percorso da seguire sul sito Web Evolis per accedere alla documentazione o ai file di installazione del 
driver della stampante. 

Funzioni disponibili solo nella versione PLUS di Badge Studio.

  Funzionamento di Badge Studio
Un documento di Badge Studio combina la progettazione di carte con la gestione dei dati di una serie 
di carte attraverso l'area di progettazione delle carte e la tabella dei dati. Questi due elementi 
funzionano in parallelo: una carta all'interno della serie corrisponde sempre a una riga della tabella dei 
dati e gli elementi sul modello della carta possono essere legati alle colonne della tabella dei dati.

  Progettazione della carta  

  Per creare un nuovo documento, selezionare un modello di 
carta predefinito o un modello di carta vergine.

  A questo punto, nell'area di progettazione delle carte, 
aggiungere, personalizzare, dimensionare e posizionare gli 
elementi (testo, immagini, codici a barre e forme) che si 
desidera visualizzare sulla serie di carte.

È possibile decidere quali elementi di testo, immagini e 
codici a barre variano da una carta all'altra e quali 
rimangono identici su tutte le carte.

  Gestione dei dati  

  Nella tabella dei dati, modificare i dati (testo, immagini, 
codici a barre) che variano da una carta all'altra. Per 
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aggiungere delle carte basate sullo stesso modello di carta 
e contenenti gli stessi elementi, è necessario aggiungere 
delle righe.

  Importare dei dati da altri documenti utilizzando una 
procedura guidata.

  Stampa  

  Per stampare delle carte, selezionare una, più o tutte le 
righe nella tabella dei dati prima di configurare e avviare la 
stampa.

  Cosa offre la versione PLUS
Sono disponibili le versioni STANDARD e PLUS di Badge Studio. La versione PLUS contiene delle 
funzionalità supplementari rispetto alla versione STANDARD:

Progettare una carta fronte-retro

Bloccare gli elementi sulla carta tramite password

Importare i dati

Eliminare i doppioni delle righe quando si importano i dati

Bloccare/Sbloccare una colonna

Stampare fronte-retro utilizzando la procedura guidata

  Per impostazione predefinita, la soluzione Badgy 100 comprende la versione STANDARD. La soluzione 
Badgy 200 comprende la versione PLUS.

Gli utenti della versione STANDARD possono usufruire delle funzionalità aggiuntive attivando una 
licenza per la versione PLUS.

  Interfaccia iniziale
L'interfaccia iniziale viene visualizzata quando viene avviato Badge Studio o quando si chiude un 
documento.
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Creare un nuovo documento

Sfogliare i documenti recenti

 

Aprire il documento

Rinominare il documento

Aprire un documento non visualizzato File > Apri un documento (Open a document)

Modificare la lingua File > Lingue (Languages)



Installazione, licenza e versioni Installare il driver e il software

7

Installazione, licenza e versioni
Installare il driver e il software

Requisiti minimi

  Sistema operativo: Windows®/macOS (Tabella di compatibilità dei software)

RAM: 2 GB

Spazio libero su disco fisso: 1,5 GB

Risoluzione dello schermo: 1024 x 768 pixel

Connettività: 1 porta USB

Webcam integrata compatibile con DirectShow, WIA o TWAIN

Installare il driver e il software a partire da una chiavetta USB

 
Per l'installazione del driver, tutte le versioni di Windows richiedono all'utente i privilegi di 
amministratore.

Non collegare la stampante prima che il processo di installazione sia terminato.

 1. Insieme alla soluzione, viene fornita una chiavetta USB contenente il driver e il software.

 2. Aprire il contenuto della chiavetta USB tramite Windows Explorer/macOS Finder.

 3. Aprire il file Setup.exe (per Windows)/Setup.pkg (per macOS).

Per impostazione predefinita, questa operazione avvia l'installazione del driver della 
stampante e del software Badge Studio.

 

 4. Una volta terminato il processo di installazione, è possibile collegare la stampate al computer 
tramite cavo USB.

Installare il driver e il software a partire da un download

 
Per l'installazione del driver, tutte le versioni di Windows richiedono all'utente i privilegi di 
amministratore.

Non collegare la stampante prima che il processo di installazione sia terminato.

 1. Accedere alla pagina Badge Studio su www.evolis.com > Sezione assistenza > Pagina del 
prodotto.

 2. Cliccare sulla versione più recente del file .exe (per Windows) /.pkg (per macOS).

 3. Cliccare su Scarica (Download).

https://downloads.evolis.com/evolis/documents/evolis-application-software-compatibilty-chart.pdf
https://it.evolis.com/
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▶  Il file .exe/.pkg è stato scaricato sul computer in uso.

 4. Al termine del download, aprire il file Setup.exe/Setup.pkg.

Per impostazione predefinita, questa operazione avvia l'installazione del driver della 
stampante e del software Badge Studio.

 

 5. Seguire le fasi di installazione visualizzate sullo schermo.

 6. Una volta terminato il processo di installazione, è possibile collegare la stampate al computer 
tramite cavo USB.

Disinstallare Badge Studio

  Windows

 1. Nel menu Start di Windows, accedere alla cartella BadgeStudioe selezionare 
BadgeStudioUninstall.

 2. Cliccare su Rimuovi per disinstallare il software dal computer.

macOS

 1. Da Applicazioni, spostare Badge Studio nel cestino.

 2. I file di configurazione e l'elenco di documenti dovranno essere rimossi manualmente.

Gestire il software, le licenze/versioni

Attivare una licenza

   1. Acquistare una licenza per la versione PLUS dal proprio rivenditore Badgy.

 2. Da Badge Studio, accedere a File > Licenza Badge Studio.

 3. Inserire il codice di attivazione inviato dal proprio rivenditore.

Se si dispone di un codice a 64 cifre, spuntare la casella corrispondente.

 4. Cliccare su Attivare la licenza (Activate License).

Attivare una licenza su un computer offline

 
È possibile attivare una licenza PLUS su un computer alla volta.

Sul computer offline:

 1. Inserire una chiavetta USB.

 2. Avviare Badge Studio.
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 3. Accedere a File  > Licenza Badge Studio.

 4. Cliccare su Altre opzioni di licenza (More licensing options), selezionare Attivare/Disattivare 
la licenza offline (Activate / Deactivate license offline) quindi cliccare su 
Attivare/Disattivare offline (Activate / Deactivate Offline).

 5. Selezionare Attivare la licenza su questo computer (Activate license on this computer) e 
cliccare su Prossimo> (Next >).

 6. Nella chiavetta USB, selezionare la posizione in cui verrà salvato il file .txt generato.

 7. Cliccare su Prossimo> (Next >) ma non interrompere la procedura guidata.

 8. Espellere la chiavetta USB.

Su un computer collegato a Internet su cui è installato Badge Studio:

 1. Inserire la chiavetta USB.

 2. Avviare Badge Studio.

 3. Accedere a File  > Licenza Badge Studio.

 4. Cliccare su Altre opzioni di licenza (More licensing options), selezionare Attivare/Disattivare 
la licenza offline (Activate / Deactivate license offline) quindi cliccare su 
Attivare/Disattivare offline (Activate / Deactivate Offline).

 5. Selezionare Attivare la licenza per un computer offline (Activate license for an offline 
computer) e cliccare su Prossimo> (Next >).

 6. Selezionare il file .txt sulla chiavetta USB.

 7. Inserire il codice di attivazione inviato dal proprio rivenditore Badgy.

 8. Cliccare su Attivare la licenza (Activate License).

 9. Nella chiavetta USB, selezionare la posizione in cui verrà salvato il file .license generato.

 10. Espellere la chiavetta USB.

Sul computer offline:

 1. Inserire la chiavetta USB.

 2. Nella procedura guidata aperta in precedenza, selezionare il file .license sulla chiavetta USB

 3. Cliccare su Attivare la licenza (Activate License).

▶  La procedura guidata attiverà la licenza PLUS su questo computer offline.

Disattivare una licenza

  Una licenza attivata con un coupon di aggiornamento può essere disattivata su un computer collegato 
a Internet.

 1. Avviare Badge Studio.

 2. Accedere a File > Licenza Badge Studio.

 3. Cliccare su Altre opzioni di licenza (More licensing options) e selezionare Attiva / Disattiva 
la licenza (Activate / deactivate license).

 4. Cliccare su Disattivare la licenza (Deactivate license).

▶  Badge Studio si collega al server delle licenze per effettuare la disattivazione.
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Disattivare una licenza su un computer offline

  Poiché la licenza PLUS può essere attivata su un solo computer offline, potrebbe essere necessario 
disattivare una licenza PLUS su un computer per poterla riattivare su un altro.

Sul computer offline in cui è installata la licenza da disattivare

 1. Inserire una chiavetta USB.

 2. Avviare Badge Studio.

 3. Dall'interfaccia iniziale, cliccare su File > Licenza Badge Studio.

 4. Cliccare su Altre opzioni di licenza (More licensing options), selezionare Attivare/Disattivare 
la licenza offline (Activate / Deactivate license offline) quindi cliccare su 
Attivare/Disattivare offline (Activate / Deactivate Offline).

 5. Selezionare Disattivare la licenza su questo computer (Deactivate license on this computer) 
e cliccare su Prossimo> (Next >).

 6. Nella chiavetta USB, selezionare la posizione in cui verrà salvato il file .txt generato.

 7. Espellere la chiavetta USB.

Su un computer collegato a Internet su cui è installato Badge Studio:

 1. Inserire una chiavetta USB.

 2. Avviare Badge Studio.

 3. Dall'interfaccia iniziale, cliccare su File  > Licenza Badge Studio.

 4. Cliccare su Altre opzioni di licenza (More licensing options), selezionare Attivare/Disattivare 
la licenza offline (Activate / Deactivate license offline) quindi cliccare su 
Attivare/Disattivare offline (Activate / Deactivate Offline).

 5. Selezionare Disattivare la licenza per un computer offline (Deactivate license for an offline 
computer) e cliccare su Prossimo> (Next >).

 6. Selezionare il file .txt sulla chiavetta USB.

 7. Cliccare su Disattivare la licenza (Deactivate license).

▶  La licenza verrà disattivata e sarà quindi possibile attivare una licenza PLUS su un altro 
computer offline.

Aggiornare il software alla versione più recente

  Da Badge Studio, accedere a Guida (Help) > Cercare gli aggiornamenti software (Check for 
software updates).

 l Se il software è aggiornato, viene visualizzato un messaggio di conferma:
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 l Se è disponibile un aggiornamento

 a. Cliccare su Scarica (Download).

▶  Sul computer in uso viene scaricato un file .exe (Windows)/.pkg (macOS).

 b. Aprire il file .exe /.pkg scaricato.

 c. Seguire le fasi di installazione visualizzate sullo schermo.

Disattivare la ricerca della versione più recente

  Per impostazione predefinita, Badge Studio effettua la ricerca della versione più recente del software 
collegandosi a un server remoto.

 1. Da Badge Studio, accedere a Guida (Help) > Cercare gli aggiornamenti software (Check for 
software updates).

 2. Deselezionare la casella Verifica automaticamente gli aggiornamenti (Automatically check 
for updates).
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Progettazione della carta
Area di progettazione delle carte

  L'area di progettazione delle carte viene visualizzata dopo aver selezionato un modello di carta o dopo 
aver aperto un documento esistente. Per impostazione predefinita, viene visualizzato solo il fronte.

  Zoom Ingrandisci/Zoom Riduci
 

  Zoom adeguato per visualizzare al meglio la carta

Visualizzare il retro

  Riprodurre il formato
 

  Annullare le azioni effettuate
 

  Ripristinare le azioni annullate
 

  Salvare il documento attuale
 

  Stampare le carte selezionate
 

  Chiudere il documento attuale e tornare 
all'interfaccia iniziale
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  Selezionare le unità di misura utilizzate per 
dimensionare/posizionare gli elementi

 Visuale (View) > Unità di misura (Measurement 
System)

  Visualizzare/Nascondere la griglia che serve per 
dimensionare/posizionare visivamente gli elementi

 Visuale (View) > Visualizzare la griglia (Show 
Grid)

  Visualizzare/Nascondere le righe che si incrociano 
al centro della carta per posizionare visivamente gli 
elementi

 Visuale (View) > Riferimenti (Guide Lines)

  Visualizzare/Nascondere le regole che indicano la 
posizione orizzontale e verticale degli elementi

 Visuale (View) > Visualizzare le regole (Show 
Rulers)

  Attivare/Disattivare l'allineamento degli elementi 
sulla griglia

 Visuale (View) > Snap > Snap sulla griglia 
(Snap To Grid)

  Visualizzare/Nascondere l'allineamento degli 
elementi rispetto agli altri

 Visuale (View) > Snap > Snap agli oggetti 
(Snap To Objects)

  Indicare l'area nascosta dal supporto del cartellino  Visuale (View) > Mostra spazio occupato dal 
supporto (Show tag holder footprint on card)

  Elementi allineati

linee blu sottili nel prolungamento dell'elemento

  Fare ruotare visivamente un elemento

 

linee rosse tratteggiate quando l'elemento viene 
ruotato di 90°/180°/270°

   

Sfondo selezionato

linea rossa punteggiata intorno al bordo della carta

Selezionare un modello di carta

Selezionare un modello di carta predefinito

   1. Dall'interfaccia iniziale, cliccare su:

 

▶  Una procedura guidata visualizzerà una serie di modelli di carte.

 2. Cliccare sul tipo di applicazione a cui saranno dedicate le carte:

 



Progettazione della carta Selezionare un modello di carta

14

 3. Per affinare la selezione dei modelli di carte, utilizzare gli elenchi a discesa e le caselle da 
spuntare:

 

 

 4. Per visualizzare i dettagli degli elementi sulla carta, posizionare il cursore su una carta e cliccare 

sull'icona delle informazioni: 

 5. Selezionare un modello di carta e cliccare su Crea (Create).

▶  Verrà visualizzata l'area di progettazione delle carte, in cui è possibile aggiungere e 
personalizzare gli elementi della carta.

Selezionare un modello di carta vergine

   1. Dall'interfaccia iniziale, cliccare su:

 

▶  Una procedura guidata visualizzerà una serie di modelli di carte.

 2. Cliccare su

 

▶  Verrà visualizzata una serie di modelli di carte vergini:

 3. Per affinare la selezione dei modelli di carte, utilizzare i filtri:

 

 4. Selezionare un modello di carta e cliccare su Crea (Create).

▶  Verrà visualizzata l'area di progettazione delle carte, in cui è possibile aggiungere e 
personalizzare gli elementi della carta.
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Personalizzare lo sfondo della carta

  Selezionare uno sfondo della carta predefinito

 1. Sul lato della carta in cui si desidera applicare lo sfondo, cliccare su un'area vuota lontana dai vari 
elementi.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Sfondo (Background), cliccare su uno degli sfondi predefiniti.

 a. Applicare sul lato fronte: cliccare sull'icona della carta a sinistra

 

 b. Applicare sul lato retro: cliccare sull'icona della carta a destra

 

   

Selezionare un'immagine da utilizzare come sfondo della carta

 1. Sul lato della carta in cui si desidera applicare lo sfondo, cliccare su un'area vuota lontana dai vari 
elementi.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Sfondo (Background), cliccare sull'icona della directory:

 3. Selezionare uno dei file immagine.

Formattare lo sfondo della carta

Sul lato della carta in cui si desidera modificare lo sfondo, cliccare su un'area vuota lontana dai vari 
elementi.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

    Proprietà immagini (Image properties)

Colori dell'immagine originale

Scala di grigi

  Monocromia
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  Negativo

 
Se si stampa utilizzando un nastro monocromo (un nastro dotato di un solo colore), le 
immagini devono avere un formato in monocromia (ma possono anche avere un formato 
negativo).

  Saturazione/Luminosità/Contrasto

 

  Ripristinare le impostazioni originali
  

  Eliminare un colore dello sfondo della carta

 1. Sul lato della carta in cui si desidera modificare lo sfondo, cliccare su un'area vuota lontana dai 
vari elementi.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Proprietà immagini (Image properties) > Elimina lo sfondo (Remove background), 
cliccare sulla piccola freccia a destra dell'icona di una persona:

 

 3. Cliccare su Contagocce (Color Picker).

▶  Il cursore diventa un contagocce.

 4. Cliccare sul colore da rimuovere.

 5. In Tolleranza (Tolerance), trascinare il cursore verso sinistra o destra per regolare la soglia di 
rimozione del colore.

 6. Per ripristinare il valore di origine, cliccare su:

  

Ritagliare l'immagine dello sfondo della carta

 1. Sul lato che presenta l'immagine dello sfondo da ritagliare, cliccare su un'area vuota lontana dai 
vari elementi.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. Cliccare su: 

 

 3. Trascinare i quadrati rossi per circoscrivere l'area desiderata dell'immagine:
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 4. Cliccare su Tronca (Crop).

Eliminare lo sfondo della carta

 1. Sul lato della carta in cui si desidera modificare lo sfondo, cliccare su un'area vuota lontana dai 
vari elementi.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. Cliccare sulla piccola freccia a destra dell'icona del panorama con una croce:

 

Nell'elenco a discesa, cliccare sul lato in cui va eliminato lo sfondo:

 

Aggiungere/Personalizzare un testo

  Aggiungere un testo

Per aggiungere un testo completamente nuovo

Cliccare sull'icona del testo:

 

Per aggiungere un testo a partire da una colonna esistente

Dalla tabella dei dati, trascinare l'intestazione della colonna sulla carta.

▶  Un elemento di testo variabile, correlato alla colonna corrispondente nella tabella dei dati, verrà 
visualizzato sulla carta e potrà essere modificato.

È possibile rendere il testo fisso in un secondo momento.

Modificare il testo
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 1. Se non è già selezionato sulla carta, cliccare sull'elemento di testo.

 2. Inserire il testo desiderato.

 3. Premere il tasto Invio.

Se il testo è collegato a una colonna della tabella dei dati, il testo contenuto nella riga corrispondente 
alla carta verrà modificato di conseguenza.

Formattare un testo

Cliccare sull'elemento di testo.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

    Font

  Colore del testo
 

  Grassetto/Corsivo/Sottolineato/Barrato
 

  Distinzione maiuscole/minuscole (ad es. minuscole)
 

  Aumentare/Diminuire la dimensione dei caratteri

 

  Font

  Dimensione dei caratteri

  Dimensione dei caratteri regolata automaticamente 
per adattare il testo alle dimensioni dell'elemento, 
rispettando la differenza tra minimo/massimo Oltre a Avanzato (Advanced) > Dimensione font 

(Font Size)  > Dimensione font minima e 
massima (Minimum and maximum sizes)

     

  Posizionamento Paragrafo (Paragraph)

  Posizione verticale all'interno dell'elemento

 

  Giustificazione

 

  Testo a capo (per mandare il testo a capo in una 
nuova riga, se necessario)  

     

  Elemento  
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  Colore sfondo/riquadro

  

  Riprodurre la formattazione di un testo

 1. Cliccare sull'elemento di testo che presenta la formattazione da riprodurre.

Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. Cliccare sull'icona di riproduzione della formattazione:

 

 3. Cliccare sull'elemento di testo a cui va applicata la formattazione.

Rendere un testo fisso

Gli elementi fissi sono identici in tutte le carte del documento e appariranno su ogni carta.

 1. Cliccare con il tasto destro del mouse sull'elemento e selezionare Trasforma in 
testo/immagine/codice a barre fisso.

▶  Viene visualizzata una finestra per confermare la trasformazione.

 2. Cliccare su OK per confermare.

▶  La colonna collegata verrà eliminata dalla tabella dei dati.

I dati di quella colonna non potranno essere recuperati.

 

Aggiungere/Personalizzare un'immagine

  Aggiungere un'immagine

Se si stampa utilizzando un nastro monocromo (un nastro dotato di un solo colore), le 
immagini che presentano una gamma di grigi/colori non sono adeguate.

Per aggiungere una nuova immagine da un file personale

Cliccare sull'icona del panorama. 

 

Aggiungere una nuova immagine dalla webcam
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Il computer deve essere dotato di una webcam.

 

 1. Cliccare sull'icona Catturare l'immagine dalla fotocamera.

 2. Quindi cliccare sull'icona della webcam per scattare la fotografia.

 3. Cliccare su Aquire per inserire la foto nel progetto della carta.

Per aggiungere un'immagine da una colonna esistente

Dalla tabella dei dati, trascinare l'intestazione della colonna sulla carta.

▶  Un'immagine variabile, correlata alla colonna corrispondente nella tabella dei dati, verrà visualizzata 
sulla carta e potrà essere formattata, dimensionata e riposizionata.

È possibile rendere l'immagine fissa in un secondo momento.

Formattare un'immagine

Cliccare sull'immagine.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

    Formato (Format)

  Colore sfondo/riquadro  

 

    Proprietà immagini (Image properties)

Colori dell'immagine originale

Scala di grigi

  Monocromia

  Negativo
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Se si stampa utilizzando un nastro monocromo (un nastro dotato di un solo colore), le 
immagini devono avere un formato in monocromia (ma possono anche avere un formato 
negativo).

  Saturazione/Luminosità/Contrasto

 

  Ripristinare le impostazioni originali
  

  Eliminare un colore da un'immagine

 1. Cliccare sull'immagine.

Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Proprietà immagini (Image properties) > Elimina lo sfondo (Remove background), 
cliccare sulla piccola freccia a destra dell'icona di una persona:

 

 3. Cliccare su Contagocce (Color Picker).

Il cursore diventa un contagocce.

 4. Cliccare sul colore da rimuovere.

 5. In Tolleranza (Tolerance), trascinare il cursore verso sinistra o destra per regolare la soglia di 
rimozione del colore.

 6. Per ripristinare il valore di origine, cliccare su:

  

Cambiare un'immagine

 1. Sulla carta, cliccare due volte sull'immagine.

 2. Selezionare un file immagine.

▶  Se l'immagine è legata a una colonna della tabella dei dati, l'immagine nella riga 
corrispondente alla carta verrà modificata di conseguenza.

Rendere un'immagine fissa

Gli elementi fissi sono identici in tutte le carte del documento e appariranno su ogni carta.

 1. Cliccare con il tasto destro del mouse sull'elemento e selezionare Trasforma in 
testo/immagine/codice a barre fisso.

▶  Viene visualizzata una finestra per confermare la trasformazione.

 2. Cliccare su OK per confermare.

▶  La colonna collegata verrà eliminata dalla tabella dei dati.
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I dati di quella colonna non potranno essere recuperati.

 

Aggiungere/Personalizzare un logo

  Aggiungere un logo

Per impostazione predefinita, un logo è un'immagine fissa sullo sfondo della carta. Gli elementi fissi 
sono identici in tutte le carte del documento e appariranno su ogni carta.

 1. Cliccare sull'icona Aggiungi logo (Add Logo).

▶  Viene aggiunta un'area dell'immagine al centro della carta e viene visualizzata la finestra di 
navigazione del sistema operativo.

 2. Selezionare l'immagine da utilizzare come logo.

 3. Cliccare su Apri (Open) per aggiungere il logo al progetto della carta.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.. 

È possibile modificare le dimensioni e la posizione del logo.

Modificare un logo

 1. Sulla carta, cliccare due volte sull'immagine.

 2. Selezionare un file immagine.

▶  Se l'immagine è legata a una colonna della tabella dei dati, l'immagine nella riga 
corrispondente alla carta verrà modificata di conseguenza.

Modificare l'origine dell'immagine di un logo

È possibile modificare l'origine dell'immagine di un logo. L'origine può essere il disco rigido (da una 
cartella del computer o da un server) o la webcam del computer.

 1. Nell'area di progettazione della carta, cliccare sul logo.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Avanzato (Advanced), cliccare su Origine immagine (Image source).

 3. Selezionare un'origine nell'elenco a discesa.

 4. Una volta modificata l'origine del logo, è possibile cliccare sull'icona della directory.
 l Quando l'origine selezionata è Dal Disco, viene visualizzato lo strumento di esplorazione 

del computer.



Progettazione della carta Aggiungere/Personalizzare un codice a barre

23

 l Quando l'origine selezionata è Webcam integrata, viene visualizzata una finestra di 
acquisizione dell'immagine.

 1. Cliccare sull'icona della webcam per scattare la fotografia.

 2. Cliccare su Aquire per inserire la foto nel progetto della carta.

Aggiungere/Personalizzare un codice a barre

  Aggiungere un codice a barre

Per aggiungere un codice a barre 1D completamente nuovo

Cliccare sull'icona del codice a barre, quindi sull'icona del codice a barre 1D:

  >  

Per aggiungere un codice a barre 2D completamente nuovo

Cliccare sull'icona del codice a barre e poi sull'icona del codice a barre 2D:

  >   

Per aggiungere un codice a barre 1D a partire da una colonna esistente

Dalla tabella dei dati, trascinare l'intestazione della colonna sulla carta.

▶  Un codice a barre, correlato alla colonna corrispondente nella tabella dei dati, verrà visualizzato sulla 
carta e potrà essere modificato.

È possibile rendere un codice a barre fisso in un secondo momento.

Modificare un codice a barre

 1. Se non è già selezionato sulla carta, cliccare sul codice a barre.

 2. Inserire i dati da codificare.

 3. Premere il tasto Invio.

▶  Se il codice a barre è collegato a una colonna della tabella dei dati, i dati contenuti nella riga 
corrispondente alla carta verranno modificati di conseguenza.

Formattare un codice a barre 1D

Una volta formattato un codice a barre 1D, si consiglia di stampare una carta di prova per 
verificare la leggibilità del codice a barre prima di stampare in serie.

Cliccare sul codice a barre.
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▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

  Codifica  

    Barcode

  Standard di codifica   

     

  Ottimizzazione della leggibilità Avanzato (Advanced) > Barcode > Ottimizzare 
(Optimize)

  Cifra supplementare utilizzata per verificare il resto 
dei dati letti

Avanzato (Advanced) > Barcode > CheckDigit

     

  Dimensioni/Disposizione

  Larghezza delle barre verticali Avanzato (Advanced) > Barcode > Larghezza 
del Modulo (Module width)

  Rapporto delle barre verticali Avanzato (Advanced) > Barcode > Risultato 
(Rendering)

  Spazio vuoto su ogni lato delle barre verticali Avanzato (Advanced) > Barcode > Distanza dai 
bordi Laterali (Quiet Zone)

  Barre che incorniciano le barre verticali Avanzato (Advanced) > Barcode > Riquadro 
(Bearer bar)

  Larghezza delle barre che incorniciano le barre 
verticali

Avanzato (Advanced) > Barcode > Larghezza 
delle Barre (Bearer width)

     

  Caratteri visibili

  Visualizzare i dati codificati sotto forma di caratteri 
visibili sulla carta

Barcode > Numeri (Human readable)

    Font

  Font

  Colore dei caratteri
 

  Dimensione dei caratteri

  Larghezza totale dei caratteri regolata 
automaticamente per adattarsi alla larghezza del 
codice a barre

Avanzato (Advanced) > Barcode > Adattare il 
testo alla codice a barre (Fit Text to Barcode)
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  Colore

    Font

  Colore del codice a barre e dei caratteri
 

    Formato (Format)

  Colore dello sfondo
 

  Colore del riquadro
 

  Formattare un codice a barre 2D

Una volta formattato un codice a barre 2D, si consiglia di stampare una carta di prova per 
verificare la leggibilità del codice a barre prima di stampare in serie.

Cliccare sul codice a barre.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

  Codifica

    Barcode

  Set di caratteri che possono essere codificati Avanzato (Advanced) > Barcode > Pagina 
codice (Code Page)

  Formato di codifica QRCode Avanzato (Advanced) > Barcode > Formato 
QRCode (QRCode Format)

  Formato di codifica Datamatrix Avanzato (Advanced) > Barcode > Codice 
Datamatrix (Datamatrix Code)

  Modalità di codifica PDF417 Avanzato (Advanced) > Barcode > PDF417 
Codifica (PDF417 Encoding)

  Modalità di codifica Maxicode Avanzato (Advanced) > Barcode > Modalità 
Maxicode (Maxicode Mode)

  Opzioni per collegare vari codici a barre Maxicode Avanzato (Advanced) > Barcode > Append #

  Formato di codifica AZTEC Rune Avanzato (Advanced) > Barcode > Modalità 
AZTEC (AZTEC Mode)

     

  Ottimizzazione della leggibilità Avanzato (Advanced) > Barcode > Ottimizzare 
(Optimize)

  Regolazione della disposizione della matrice Avanzato (Advanced) > Barcode > Maschera 
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(Mask)

  Ridondanza per garantire la leggibilità se una parte 
del codice a barre è sporca o danneggiata

Avanzato (Advanced) > Barcode > Livello EC 
(EC Level)

     

  Dimensioni/Disposizione

  Numero di quadrati che formano la matrice Avanzato (Advanced) > Barcode > Dimensione 
(Size)  > Dimensione/Versione (Size/Version)

  Dimensione dei quadrati che formano la matrice Avanzato (Advanced) > Barcode > Larghezza 
del Modulo (Module width)

  Altezza delle righe all'interno della matrice Avanzato (Advanced)  > Barcode  > Altezza 
delle Righe (Row height)

  Larghezza delle colonne all'interno della matrice Avanzato (Advanced) > Barcode > Larghezza 
delle Colonne (Column width)

  Segmenti di dati per riga Avanzato (Advanced) > Barcode > Segmenti di 
dati (Data Segments)

  Rapporto tra righe e colonne Avanzato (Advanced) > Barcode > R/C Ratio

  Spazio vuoto intorno alla matrice Avanzato (Advanced) > Barcode > Distanza dai 
bordi Laterali (Quiet Zone)

     

  Colore

    Font

  Colore dei quadrati che formano la matrice
 

    Formato (Format)

  Colore dello sfondo
 

  Colore del riquadro
 

  Rendere un codice a barre fisso

Gli elementi fissi sono identici in tutte le carte del documento e appariranno su ogni carta.

 1. Cliccare con il tasto destro del mouse sull'elemento e selezionare Trasforma in 
testo/immagine/codice a barre fisso.

▶  Viene visualizzata una finestra per confermare la trasformazione.

 2. Cliccare su OK per confermare.

▶  La colonna collegata verrà eliminata dalla tabella dei dati.
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I dati di quella colonna non potranno essere recuperati.

 

 

Aggiungere/Formattare una forma

  Aggiungere una forma di base

 1. Cliccare sull'icona della forma:

 

 2. Quindi su una forma nel menu:

 

▶  La forma verrà visualizzata sulla carta e potrà essere formattata, dimensionata e riposizionata:

Formattare una forma

Cliccare sulla forma.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

    Formato (Format)

  Colore di fondo
 

  Colore del riquadro
 

Opacità  Avanzato (Advanced) > Articolo (Item) > 
Opacità (Opacity)
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Aggiungere/Personalizzare una vCard

Una vCard consente di codificare le informazioni stampate su un biglietto da visita in un codice QR. 
Scansionando questo codice QR, è possibile creare un nuovo contatto direttamente nel proprio 
telefono, localizzare l'azienda con un'applicazione GPS, chiamare il numero di telefono fornito, inviare 
un'e-mail all'indirizzo di posta elettronica fornito, copiare o condividere le informazioni.

A seconda della marca del telefono utilizzato per la scansione della vCard, quando si 
aggiungono informazioni a un nuovo contatto si possono osservare i seguenti 
comportamenti:

 l I campi collegati all'indirizzo (campi da 9 a 13) possono essere raggruppati in un 
unico campo di contatto.

 l I campi collegati al lavoro (campi da 4 a 6) possono essere raggruppati in un unico 
campo di contatto.

Garantire la leggibilità della vCard con codice QR
 l Gli elementi in primo piano (neri per impostazione predefinita) devono essere di un colore più 

scuro rispetto allo sfondo (bianco, per impostazione predefinita).
 l Una combinazione con primo piano giallo e sfondo bianco rende il codice QR illeggibile.
 l Ecco perché è fondamentale assicurarsi che vi sia abbastanza contrasto tra il primo piano e lo 

sfondo del codice QR.
 l La dimensione minima per una buona leggibilità è di 2x2 cm.
 l Aggiungere un riquadro di almeno 1/4 pt dello stesso colore dello sfondo del codice QR.

Aggiungere una vCard

Cliccare sull'icona vCard.

▶  Sul biglietto viene visualizzato un codice QR. La vCard con codice QR viene visualizzata su tutte le 
righe del database.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

Salvare le informazioni

Modalità vCard classica

 1. Se non è già selezionata sulla carta, cliccare sulla vCard con codice QR.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. Nella sezione Campi vCard (vCard Fields): 
 l È possibile collegare ogni campo a una colonna della tabella dei dati esistente.
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 a. Cliccare sulla freccia accanto al campo Scegli la colonna ... (Choose column).

 b. Selezionare la colonna della tabella dei dati.
 l È possibile inserire le informazioni a mano.

Le informazioni inserite manualmente vengono attribuite a tutte le righe del 
database.

 

▶  Le informazioni registrate per la riga selezionata vengono visualizzate al di sotto:

La foto del contatto è disponibile solo quando la modalità vCard dinamica 
è attiva.

Modalità vCard dinamica

Nella modalità vCard classica, le informazioni sono memorizzate nel codice QR stesso. Più campi 
vCard sono compilati, più il codice QR risulta intricato, il che può renderlo illeggibile a seconda delle 
dimensioni.
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5 campi vCard compilati 15 campi vCard compilati

Nella modalità vCard dinamica, il codice QR memorizza solo un URL e non cambia se vengono 
compilati altri campi. Tutte le informazioni sono memorizzate su un server pubblico Badgy. Questo 
rende il codice QR meno intricato. Quando il codice QR viene scansionato, le informazioni di contatto 
vengono scaricate sul telefono tramite l'URL.

Per utilizzare la modalità vCard dinamica, il computer deve essere connesso a Internet.

Quando si scansiona la vCard con codice QR, il telefono deve essere connesso a Internet 
(dati mobili o Wi-Fi).

Quando la modalità vCard dinamica è attiva, salvare sempre il documento ogni volta che 
viene implementata una modifica su una vCard con codice QR. Prima che il documento 
venga salvato, il codice QR è illeggibile e le informazioni non vengono salvate/aggiornate 
sul server.

Per attivare la modalità vCard dinamica:

Quando si utilizza la modalità vCard dinamica:
 l L'eliminazione di una riga dalla tabella dati rende non disponibili le informazioni 

collegate a quella riga. La scansione della vCard con codice QR su una tessera 
precedentemente stampata non fornirà più l'accesso alle informazioni di contatto.

 l L'eliminazione della vCard con codice QR dal progetto di una tessera rende non 
disponibili le informazioni collegate a questo codice QR. La scansione di tessere 
precedentemente stampate non fornirà più l'accesso alle informazioni di contatto.

 l Lavorando su due copie dello stesso documento Badge Studio (copiate da Esplora 
risorse di Windows o da macOS Finder) si verificano incongruenze se le righe 
vengono aggiunte, modificate o eliminate in un documento ma non nell'altro.

 l Quando un documento viene salvato come..., le due versioni del documento hanno 
vCard con codice QR diverse. Entrambe le versioni del documento possono essere 
utilizzate senza alcuna incongruenza.

 1. Se non è già selezionata sulla carta, cliccare sulla vCard con codice QR.

 2. In Campi vCard (vCard Fields), spuntare la casella Attivare la modalità vCard dinamica 
(Activate dynamic vCard mode).

 3. Viene visualizzata una finestra pop-up che informa che verranno create nuove vCard con 
codice QR per ogni riga della tabella dei dati e che tutte le carte dovranno essere 
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ristampate.

 4. Cliccare su Sì per attivare l'opzione.

 5. Cliccare sull'icona Salva (Save).

Modificare le informazioni sulla vCard

 1. Se non è già selezionata sulla carta, cliccare sulla vCard con codice  QR .

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. Cliccare su Rimuovere il contenuto (Delete content) per svuotare tutti i campi e inserire 
nuove informazioni.

O

 3. Modificare l'informazione direttamente nel database.

▶  L'informazione viene modificata sulla carta e nell'anteprima dei campi vCard.

 4. Cliccare sull'icona Salva (Save).

Formattare una vCard con codice QR

Se non è già selezionata sulla carta, cliccare sulla vCard con codice QR .

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

    Formato (Format)

  Colore del codice QR

  Colore dello sfondo

  Colore del riquadro

  Riprodurre il formato

    Formato (Format) > Modello (Pattern)

  Modificare la forma del motivo della vCard con 
codice QR

     Formato (Format) > Organizza (Arrange)

  Allineare con precisione il codice QR
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  Ruotare con precisione il codice QR

  Spostare il codice QR in primo piano/sullo sfondo

  Personalizzare una vCard con codice QR

Le vCard con codice QR possono essere personalizzate aggiungendo un'immagine al codice QR (come il 
logo dell'azienda).

Logo al centro della vCard con codice QR

Aggiungere un logo al centro di una vCard con codice QR

 1. Se non è già selezionato sulla carta, cliccare sul codice a barre della vCard con codice  QR .

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Logo, cliccare sull'icona della directory e selezionare l'immagine che si desidera aggiungere.

 3. Il logo viene aggiunto al centro della vCard con codice QR con uno sfondo bianco, se necessario.
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Modificare le dimensioni di un logo in una vCard con codice QR

 1. Se non è già selezionata sulla carta, cliccare sulla vCard con codice QR .

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. Utilizzare il cursore per regolare la dimensione del logo.

Piccolo: il logo occupa il 5% del codice QR.

Medio: il logo occupa l'8% del codice QR (regolazione predefinita).

Grande: il logo occupa l'11% del codice QR.

Eliminare un logo da una vCard con codice QR

 1. Se non è già selezionata sulla carta, cliccare sulla vCard con codice QR .

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Logo, cliccare sull'icona di ripristino accanto a Sfoglia file (Browse file):

▶  Il logo viene rimosso dalla vCard con codice QR e dall'anteprima del logo selezionato.

Dimensionare/Posizionare gli elementi

Ritagliare un'immagine

  Cliccare sull'immagine.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

Per riempire completamente il riquadro esistente

In Avanzato (Advanced) > Regola (Fit), cliccare su Tagliare per adattare (Crop to Fit).

Per visualizzare l'intera immagine nel riquadro esistente

In Avanzato (Advanced) > Regola (Fit), cliccare su Adatta al formato (Shrink to fit).

Per ritagliare un'area specifica dell'immagine

 1. In Formato (Format), cliccare sull'icona Tronca.

 

 2. Trascinare i quadrati rossi per circoscrivere l'area desiderata dell'immagine:
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 3. Cliccare su Tronca (Crop).

Per ritagliare un'immagine in base a una forma

 1. In Formato (Format), cliccare sulla piccola freccia a destra dell'icona con due forme intrecciate:

 

 2. Quindi selezionare una delle forme elencate:

 

▶  Alcune parti dell'immagine verranno nascoste per adattare l'immagine alla forma selezionata:

Spostare un elemento sul lato opposto della carta

 1. Se il retro della carta non è visualizzato, cliccare su 

 2. Cliccare sull'elemento, posizionando il cursore verso il riquadro in modo da visualizzare la freccia 
a quattro teste.

 3. Cliccare sull'elemento e trascinarlo e rilasciarlo sul lato opposto della carta.
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Spostare un elemento in avanti o indietro

  Nello stesso spazio, le parti degli elementi su un piano avanti nascondono quelle degli elementi sul 
piano indietro. Ogni elemento sulla carta occupa un piano che ne determina la visibilità in rapporto agli 
altri.

Per spostare sul piano avanti

Cliccare con il tasto destro del mouse su un elemento e cliccare su Porta avanti (Bring forward) o 
Porta in primo piano (Bring to front).

Per spostare sul piano indietro

Cliccare con il tasto destro del mouse su un elemento e cliccare su Porta indietro (Send backward) o 
Porta in secondo piano (Send to back).

Ridimensionare un elemento per riempire la carta in modo pro-
porzionale

  Cliccare con il tasto destro del mouse su un elemento e cliccare su Adatta alla card (Fit to Card).

Allineare/Distribuire gli elementi

   1. Premere e tenere premuto il tasto Ctrl (Windows)/cmd (macOS) e cliccare sugli elementi da 
allineare/distribuire.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Formato (Format) > Organizza (Arrange), cliccare sull'icona di allineamento, quindi 
selezionare un'opzione:

  

  

Fare ruotare un elemento in modo preciso

   1. Cliccare sull'elemento che si desidera ruotare.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.
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 2. In Formato (Format) > Organizza (Arrange), cliccare sulla piccola freccia a destra dell'icona di 
rotazione e scegliere una delle opzioni predefinite o inserire l'angolo di rotazione nel campo:

 

 

Dimensionare/Posizionare con precisione un elemento

   1. Cliccare sull'elemento da dimensionare/posizionare.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Avanzato (Advanced), cliccare su Dimensione (Size) > Posizione (Position).

 3. Inserire larghezza/altezza/posizione nel campo:

 

Bloccare/Nascondere gli elementi

Bloccare/Sbloccare un elemento sulla carta

   1. Cliccare sull'elemento.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Avanzato (Advanced) > Articolo (Item), selezionare/deselezionare Proteggere l'elemento 
(Lock item).

Bloccare tutti gli elementi senza password

  Nell'area di progettazione delle carte, cliccare sull'icona con il lucchetto (non sulla piccola freccia a 

destra): 

▶  I dati della tabella collegati agli elementi sulla carta non vengono bloccati.

È sempre possibile stampare delle carte.
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Bloccare gli elementi sulla carta tramite password

 1. Cliccare sulla piccola freccia a destra dell'icona con il lucchetto,

 

Quindi, cliccare su Blocco modello tramite password (Lock design with password) > .

 2. Inserire e confermare la password scelta:

  

Se la si dimentica, non è possibile reimpostare la password.

 

 3. Cliccare su OK.

I dati della tabella collegati agli elementi sulla carta non vengono bloccati.

È sempre possibile stampare delle carte.

Sbloccare gli elementi sulla carta

   1. Nell'area di progettazione delle carte, cliccare sull'icona con il lucchetto (non sulla piccola freccia 
a destra):

 

 2. Inserire la password definita in precedenza.

 3. Cliccare su OK.

 
Questa azione non sblocca le colonne bloccate collegate agli elementi sulla carta.

Disattivare il blocco tramite password

 1. Nell'area di progettazione delle carte, cliccare sulla piccola freccia a destra dell'icona con il 
lucchetto
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Quindi cliccare su Disattiva blocco tramite password (Disable password protection).

 2. Inserire la password definita in precedenza.

 3. Cliccare su OK.

Nascondere/Visualizzare gli elementi sulla carta

  Nell'intestazione della colonna collegata all'elemento, cliccare sull'icona dell'occhio.

/ .

Un elemento nascosto non verrà stampato.

Copiare/Eliminare degli elementi

Copiare e incollare un elemento

   1. Cliccare con il tasto destro del mouse su un elemento e cliccare su Copia (Copy).

 2. Cliccare con il tasto destro del mouse sul lato e nell'area in cui si desidera aggiungere la copia, 
quindi cliccare su Incolla (Paste).

▶  Se variabile, l'elemento copiato sarà collegato a una nuova colonna nella tabella dei dati.

Duplicare un elemento

  Cliccare con il tasto destro del mouse su un elemento e cliccare su Duplicato (Duplicate).

Se variabile, l'elemento originale e gli elementi duplicati verranno collegati alla stessa 
colonna nella tabella dei dati e verranno aggiornati tutti ogni volta che uno di questi 
elementi viene modificato.

Eliminare un elemento

  Cliccare con il tasto destro del mouse su un elemento e cliccare su Elimina (Delete).

Le colonne collegate non vengono rimosse dalla tabella dei dati.
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Gestione dei dati
Tabella dei dati

 La tabella dei dati sotto l'area di progettazione delle carte contiene i dati che possono essere visualizzati sulle 
carte. È organizzata in colonne* (ogni colonna raggruppa dati di un certo tipo) e righe* (ogni riga 
corrisponde a una carta).

 

 Aggiungere una riga
  

 Navigare tra una riga e l'altra (e visualizzare 
le carte corrispondenti)   

 Cercare i dati  

 Selezionare una, diverse o tutte le righe

 

 Eliminare la riga o le righe selezionate
  

Aggiungere una riga

  In fondo alla tabella dei dati, cliccare sull'icona a forma di più:

  

▶  Verrà aggiunta al documento una riga basata sullo stesso modello di carta e contenente gli stessi 
elementi delle altre carte.

È possibile modificare i dati direttamente nelle celle di questa riga.

Aggiungere una colonna

   1. Cliccare con il tasto destro del mouse su un'intestazione della colonna qualunque.

 2. Cliccare su Aggiungere una colonna (Add column) e selezionare il tipo di colonna da 
aggiungere (Aggiungi una colonna codice a barre (Add barcode column) /Aggiungi 
colonna immagine (Add image column)/Aggiungi una colonna testo (Add text column)).

È possibile aggiungere elementi collegati alla carta in un secondo momento (testo, immagine, 
codice a barre).
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Aggiungere/Importare dei dati

Preparare un database esterno

  Preparare un database di tipo foglio di calcolo

È necessario osservare le seguenti regole:
 l I dati che possono essere importati sono gli oggetti disponibili nel software (caselle di testo, 

immagini, informazioni sui codici a barre, loghi, ecc.).
 l Compilare il foglio di calcolo come segue: nomi delle colonne nella prima riga del foglio di 

calcolo e valori da visualizzare nelle righe successive.
 l Non includere celle unite. Non possono essere importate nel software.
 l Per includere le immagini in un database di fogli di calcolo, utilizzare la funzione Collegamento.

Preparare un database .txt

È necessario osservare le seguenti regole:
 l La prima riga deve essere usata come esempio per l'intero file .txt e corrisponde ai titoli delle 

colonne del database. (1)
 l Seguire sempre l'esempio della prima riga per compilare il file .txt.
 l Per aggiungere delle immagini, utilizzare il percorso completo e il nome dell'immagine (con 

l'estensione del file).
 l Se le righe devono essere importate in un ordine specifico, aggiungere un numero come prima 

voce. Aggiungere un nome della colonna ai numeri della riga in modo che non vengano 
importati come voci. (2)

 l Separare ogni elemento con un delimitatore: virgola (,) o punto e virgola (;). (3)

Se non viene rilevato alcun delimitatore, l'importazione non funzionerà correttamente.
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Importare i dati

Importare i dati da un documento Excel /CSV/.txt

Selezionare il file da importare

 1. Aprire il documento Badge Studio nel quale si desidera importare i dati.

 2. Cliccare su File > Importa dati (Import data).

▶  Viene visualizzata la finestra di importazione.

 3. Cliccare sulla scheda Importazione (Import) > Importa da Excel / CSV / TXT (Import from 
EXCEL / CSV / TXT)

 4. Cliccare su Sfoglia file (Browse file) e selezionare il documento che contiene i dati da importare.

Per specificare i dati in un documento Excel da importare:

 1. Selezionare Opzioni avanzate (Advanced options).

 2. Selezionare il foglio dall'elenco a discesa e/o specificare l'intervallo di celle 
contenenti i dati:

Per sincronizzare i dati con un documento Excel:

 1. Selezionare Opzioni avanzate (Advanced options).

 2. Selezionare Aggiornamento automatico dei dati (Auto Import Data).

 3. Selezionare una delle opzioni descritte.

 5. Cliccare su Prossimo> (Next >).

  Collegare gli elementi sulla carta alle colonne del file.

▶  Nella finestra di dialogo verranno visualizzati gli elementi presenti sul modello della carta a sinistra e 
le colonne del documento importato a destra:
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 1. Cliccare su Mostra altre colonne della mia tabella (Show more columns from my table) per 
visualizzare le colonne della tabella dei dati non collegate a elementi presenti sulla carta.

▶  Le colonne verranno visualizzate sotto la carta:

 2. Cliccare sull'elemento (o colonna) a sinistra, quindi cliccare sulla colonna corrispondente a destra 
per ogni elemento (o colonna non collegata) da collegare a una colonna del documento 
importato.

▶  Negli elementi e nelle colonne collegate verrà visualizzato un punto con lo stesso colore e 
numero:

Per specificare una o più colonne di riferimento:

 1. Cliccare su Avanzato (Advanced).

 2. Se non è già stata selezionata, selezionare la casella accanto alla colonna del 
documento importato.

 3. Cliccare sull'icona con la chiave accanto alla colonna del documento importato: 

▶  Le colonne di riferimento sono contrassegnate da un'icona con una chiave blu:

 4. Cliccare su OK.

 3. Dopo aver collegato tutti gli elementi e le colonne, cliccare su Prossimo> (Next >), quindi su 
Fine (Finish).
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Modificare i dati

Modificare i dati di tipo testo nella tabella dei dati

   1. Cliccare due volte sulla cella della tabella dei dati (nella riga della carta corrispondente) 
contenente il valore da cambiare.

 2. Inserire il valore desiderato nella cella della tabella dei dati.

 3. Premere il tasto Invio.

▶  Il valore sulla carta corrispondente alla riga cambierà di conseguenza.

Modificare un'immagine nella tabella dei dati

   1. Cliccare due volte nella cella della tabella dei dati (nella riga della carta corrispondente) 
contenente l'immagine da cambiare.

▶  Viene visualizzato lo strumento di esplorazione del computer.

 2. Selezionare un file immagine.

▶  L'immagine sulla carta corrispondente alla riga cambierà di conseguenza.

 

Collegare un elemento a un'altra colonna

  Quando si aggiunge un nuovo elemento alla carta, viene creata automaticamente una colonna 
corrispondente nella tabella dei dati. L'elemento può essere collegato a un'altra colonna della tabella di 
dati (se è già stato importato un database contenente le informazioni per l'elemento).

 1. Cliccare sull'elemento sulla carta.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Avanzato (Advanced)  > Database, nell'elenco a discesa, selezionare la colonna da collegare.

▶  L'elemento è ora collegato a una nuova colonna e i dati visualizzati sulla carta vengono 
aggiornati.

Rendere un elemento fisso

  Gli elementi fissi sono identici in tutte le carte del documento e appariranno su ogni carta.

 1. Cliccare con il tasto destro del mouse sull'elemento e selezionare Trasforma in 
testo/immagine/codice a barre fisso.

▶  Viene visualizzata una finestra per confermare la trasformazione.

 2. Cliccare su OK per confermare.

▶  La colonna collegata verrà eliminata dalla tabella dei dati.

I dati di quella colonna non potranno essere recuperati.
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Rinominare una colonna

   1. Cliccare con il tasto destro del mouse sull'intestazione della colonna, quindi cliccare su Rinomina 
la colonna (Rename column).

 2. Inserire il nome nuovo direttamente nell'intestazione della colonna.

 3. Premere il tasto Invio.

Cercare/Ordinare i dati

Cercare i dati

   1. Inserire le informazioni desiderate nella barra di ricerca (testo/dati del codice a barre):

 2. Selezionare una colonna nell'elenco a discesa a destra della barra di ricerca per affinare la ricerca:

  

▶  Verranno visualizzate solo le righe corrispondenti esattamente ai criteri di ricerca.

 3. Eliminare tutti i caratteri nel campo di ricerca per visualizzare nuovamente tutte le righe.

Riorganizzare le colonne

  Cliccare con il tasto destro del mouse sull'intestazione della colonna, quindi cliccare su Sposta a 
sinistra (Move left) o Sposta a destra (Move right).

Bloccare/Nascondere i dati

Bloccare/Sbloccare una colonna

 1. Cliccare con il tasto destro del mouse sull'intestazione della colonna, quindi cliccare su Opzioni 
avanzate (Advanced options).

 2. Spuntare/Togliere il segno di spunta a Proteggi la colonna (Protect column).

▶  I dati in una colonna bloccata non possono essere modificati, copiati o eliminati.

Qualsiasi elemento collegato a una colonna bloccata può essere personalizzato, 
dimensionato e riposizionato.
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Nascondere una colonna

  Cliccare con il tasto destro del mouse sull'intestazione della colonna, quindi cliccare su Nascondi 
(Hide).

▶  Anche gli elementi corrispondenti sulla carta verranno nascosti.

Visualizzare una colonna

   1. Cliccare con il tasto destro del mouse su un'intestazione della colonna qualsiasi e cliccare su 
Visualizza (Unhide).

 2. Selezionare la casella della colonna da visualizzare.

▶  Verrà visualizzato anche l'elemento corrispondente sulle carte.

Copiare/Esportare dei dati

Copiare e incollare una riga

   1. Cliccare con il tasto destro del mouse su una cella qualsiasi della riga contenente i dati da 
copiare, quindi cliccare su Copia la riga (Copy line).

 2. Cliccare con il tasto destro del mouse su una cella qualsiasi della riga contente i dati da sostituire, 
quindi cliccare su Incolla la riga (Paste line).

▶  I dati presenti nella riga verranno sostituiti.

Duplicare una riga

  Cliccare con il tasto destro del mouse su una cella qualsiasi della riga contente i dati da duplicare, 
quindi cliccare su Duplica la riga (Duplicate row).

▶  Alla tabella dei dati verrà aggiunta una riga contenente gli stessi dati.

È possibile modificare questa riga in un secondo momento senza che l'altra venga aggiornata.

Propagare un valore/immagine nell'intera colonna

   1. Cliccare con il tasto destro del mouse sulla cella della tabella dei dati contenente il 
valore/l'immagine da propagare.

 2. Selezionare Applica l'immagine a tutte le righe (Apply image to all rows)/Applica il valore a 
tutte le righe (Apply value to all rows).

▶  Il valore/L'immagine verrà propagato in tutte le celle della stessa colonna.

È possibile modificare in un secondo momento qualsiasi cella della colonna senza 
aggiornarle tutte.
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Esportare i dati

 1. Aprire il documento contenente i dati da esportare.

 2. Cliccare su File > Esporta dati (Export data).

 3. Cliccare sull'icona della directory:

 4. Selezionare la posizione in cui verranno archiviati i dati.

 5. Deselezionare le caselle delle colonne che non si desidera esportare.

 6. Cliccare su Esporta (Export).

▶  Una cartella compressa contenente un file Excel dei dati esportati viene salvata nella posizione 
selezionata.

Eliminare i dati

Eliminare le righe

   1. Selezionare le righe da eliminare.  

   l Per selezionare una o più righe da eliminare, 
spuntare le caselle relative alle righe in 
questione.

 

   l Per selezionare una serie di righe da 
eliminare, spuntare la casella a una delle 
estremità del gruppo di righe, premere il 
tasto Maiusc e tenerlo premuto mentre si 
seleziona la casella all'altra estremità della 
serie di righe.

 

   l Per selezionare tutte le righe da cancellare, 
selezionare la casella sopra la casella 
corrispondente alla prima riga.

 

   2. Cliccare sull'icona del cestino.

  

I dati eliminati non possono essere 
recuperati.

 



Gestione dei dati Eliminare i dati

47

Eliminare una colonna

  Cliccare con il tasto destro del mouse sull'intestazione della colonna, quindi cliccare su Eliminare la 
colonna (Delete column).

I dati eliminati non possono essere recuperati.

Verranno rimossi anche tutti gli elementi collegati alla carta.
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Stampa
Interfaccia di stampa

  L'interfaccia di stampa viene visualizzata dopo aver selezionato le carte da stampare e dopo aver 
cliccato sull'icona della stampante nell'area di progettazione delle carte. Consente di configurare le 
impostazioni di stampa prima di avviare la stampa.

  

  Aggiornare l'elenco delle stampanti disponibili
  

  Formato delle carte Dimensione della carta (Card size):

Carta lunga 120 x 50 mm (Long card 120 x 50 mm)

Carta lunga 150 x 50 mm (Long card 150 x 50 mm)

  Carte di dimensioni pari a quelle di una carta di 
credito standard

CR80

  Conformità con lo standard ISO che definisce le 
caratteristiche fisiche delle carte

CR80 (ISO7810)

  Per stampare il fronte
  

Per stampare il retro

  

  Per stampare fronte-retro

  

  Laminatura (Anti-aliasing) Avanzato (Advanced) > Risultato (Rendering) 
> Laminatura (Anti-aliasing)
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  Risoluzione di stampa Avanzato (Advanced) > Impostazioni della 
stampante (Printer settings) > Risoluzione (DPI) 
(Resolution (DPI))

  Orientamento del contenuto sul retro in rapporto a 
quello sul fronte

Avanzato (Advanced) > Impostazioni della 
stampante (Printer settings) > Ruotare il retro 
di 180 gradi (Rotate Back 180 degrees)

  Per avviare la stampa

  

Stampare le carte

Verificare lo stato della stampante (Windows)

  Aprire Badgy Print Center (ad esempio, dal menu Start di Windows o da un'icona sul desktop).

Lo stato della stampante dovrebbe essere Pronto (Ready):

 

Se lo stato della stampante non è "Pronto (Ready)", consultare le risorse di supporto (compresa la guida 
per l'utente) per le stampanti Badgy.

Selezionare le carte da stampare

  Per selezionare una o più righe da stampare, 
spuntare le caselle relative alle righe in questione.

 

  Per selezionare una serie di righe da stampare, 
spuntare la casella a una delle estremità del gruppo 
di righe, premere il tasto Maiusc e tenerlo premuto 
mentre si seleziona la casella all'altra estremità della 
serie di righe.

  

https://myplace.evolis.com/s/product/badgy-200/01t5p00000CXScjAAH?language=it&tabset-4085f=1
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  Per selezionare tutte le righe da stampare, 
selezionare la casella sopra la casella corrispondente 
alla prima riga.

 

  

Configurare in modo da non stampare un determinato elemento

   1. Cliccare sull'elemento sulla carta.

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Avanzato (Advanced)  > Articolo (Item), deselezionare Stampa (Print).

Configurare in modo da non stampare lo sfondo della carta

   1. Cliccare su Edita (Edit) > Modifica lo sfondo (Edit card background).

▶  Il pannello delle proprietà verrà visualizzato a destra dell'area di progettazione delle carte.

 2. In Avanzato (Advanced) > Sfondo (Background), spuntare Non stampare sfondo (Don't 
Print Background).

Configurare/Avviare la stampa

   1. Cliccare sull'icona della stampante nell'area di progettazione delle carte:

 

▶  Verrà visualizzata l'interfaccia di stampa:

 

 2. Configurare le impostazioni di stampa disponibili

 3. Cliccare sull'icona Stampa (Print) dopo aver configurato le impostazioni di stampa.

Spuntare la casella Stampare il verso con l'assistente di stampa doppio lato (Print the back side 
using the duplex printing wizard)
▶  Viene visualizzata una procedura guidata: 
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Seguire le istruzioni visualizzate sullo schermo.
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Codici e supporto
  Opzioni di stampa
  laminatura

Una tecnica che mira a una resa più uniforme dei pixel, attenuando 
l'aspetto frastagliato dei bordi. Le impostazioni di stampa consentono 
di specificare se la laminatura viene applicata al testo, alle immagini o a 
entrambi.

   

  luminosità

La misura in cui un'immagine sembra irradiare luce. Una luminosità 
elevata sposta la gamma tonale verso il bianco.

livello basso livello elevato

  contrasto

La differenza tra le parti scure e quelle chiare di un'immagine. Un 
contrasto elevato amplia la gamma tonale, enfatizzando le differenze 
tra le parti scure e quelle chiare di un'immagine. Sul piano fisico, con 
un contrasto maggiore, la testina di stampa viene riscaldata a una 
temperatura più elevata e viene applicata una quantità maggiore di 
colorante sulla carta.

livello basso livello elevato

  scala di grigi

Sfumature dal nero assoluto al bianco assoluto. Al contrario, 
un'immagine monocromatica non presenta queste sfumature tra il 
nero assoluto e il bianco assoluto.

 

  monocromia

Il termine significa "un colore", ma il significato pratico varia a seconda 
del settore.

In fotografia e in grafica, un'immagine monocromatica è composta 
solo da nero assoluto e bianco assoluto, senza sfumature di grigio o 
altri colori tra questi estremi.

Nella stampa, un nastro monocromatico ha un solo colore (solitamente 
bianco o nero) e quindi applica il colore del suo colorante o non ne 
applica affatto.

Quando si stampa un'immagine con un nastro monocromatico, è 
necessario:

 l Selezionare un'immagine con zone chiare e scure nette. Non 
deve presentare sfumature di grigio o altri colori.

 l Convertire le immagini in formato monocromia. Badge Studio 
offre questa opzione di formattazione per un'immagine 
aggiunta alla carta o per lo sfondo della carta.

 



Codici e supporto Tipi di codici a barre

53

  negativo

Un'immagine in cui i colori scuri e chiari sono stati invertiti. In 
un'immagine monocromatica, il nero assoluto e il bianco assoluto sono 
invertiti. Questo è particolarmente utile quando si stampa con un 
nastro bianco su carte nere.

 

  risoluzione di stampa

La risoluzione di stampa è la densità dei punti di colorante applicati 
dalla testina di stampa alla carta. Si misura in punti per pollice (dpi). 
L'aumento della risoluzione di stampa può migliorare la qualità delle 
immagini con dettagli fini, ma riduce la velocità di stampa.

Le risoluzioni di stampa possibili dipendono dal modello della 
stampante e dal tipo di nastro (monocromia o a colori):

Stampante a colori/monocromia risoluzione (DPI)

BADGY 100 monocromia 300

BADGY 200 monocromia 300

   

  saturazione

La vividezza dei colori di un'immagine.

livello basso livello elevato

  Tipi di codici a barre
  Codice a barre 1D

Codice a barre classico che codifica dei dati tramite barre verticali.

 

  Codice a barre 2D

Codice a barre che codifica i dati in una matrice di piccoli quadrati.

I codici a barre 2D sono in grado di codificare più dati rispetto ai codici 
a barre 1D. Possono quindi essere utilizzati per indirizzi Web o 
informazioni di serie dettagliate.

 

  Codice QR

Marchio registrato. Uno standard di codifica per i codici a barre 2D.

   

  Formati delle carte
  carta di credito

Carte di dimensioni pari a quelle di una carta di credito standard (86 x 
54 mm), fornite insieme alle soluzioni.
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  Guida

Scaricare un PDF

È possibile scaricare una versione di questa guida in formato PDF da www.evolis.com  > Sezione 
assistenza > Pagina del prodotto.

È possibile accedere al PDF anche selezionando il pulsante Guida (Help) del software.

Video di maneggevolezza

Il video di maneggevolezza presenta le funzioni più importanti offerte da Badge Studio. Viene 
riprodotto quando si avvia il software per la prima volta.

È possibile riprodurre il video di maneggevolezza in qualsiasi momento dall'interfaccia iniziale cliccando 
su Guida (Help) > Avviare il video di maneggevolezza (Launch guided tour video).

Tutorial

Guardare i video tutorial sul canale YouTube Badgy.

Knowledge base

Cercare nella knowledge base online.

Assistenza tecnica

 l Contattare il servizio di assistenza del proprio rivenditore.
 l Compilare questo modulo online.

https://it.evolis.com/
https://www.youtube.com/@badgycardprinter/featured
https://myplace.evolis.com/s/topic/0TO5p000001UPchGAG/evolis-badge-studio?language=it
https://myplace.evolis.com/s/contactsupport?language=it
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C

colonna
Nella tabella dei dati, una colonna raggruppa dei dati di un determinato tipo. Ad esempio, una 
colonna chiamata "Origine" che presenta il nome di un luogo per ogni riga (che rappresenta 
una carta). Quando una colonna viene collegata a un elemento variabile sulla carta, funge da 
sorgente dei dati.

colonna di riferimento
Una colonna utilizzata per identificare e gestire le righe duplicate. La colonna di riferimento può 
essere impostata automaticamente dal software o definita dall'utente. Può essere o meno una 
colonna collegata a un elemento presente sulla carta. È possibile definire più colonne di 
riferimento per gli stessi dati se una singola colonna di riferimento non è sufficiente a 
identificare in modo univoco le righe.

D

dati
Il testo, le immagini, i dati codificati con codice a barre e le informazioni sugli allergeni 
contenuti nella tabella dei dati.

documento
Un file Badge Studio (con estensione .bs) contenente una tabella di dati e un modello di carta 
per una serie di carte.

E

elemento
Gli elementi che possono essere aggiunti al modello della carta e personalizzati/formattati. Un 
elemento variabile è collegato a una colonna della tabella dei dati.

F

fisso
gli elementi fissi del modello della carta (contrariamente agli elementi variabili) sono identici in 
tutte le carte del documento e appariranno su ogni carta. Ad esempio, è possibile aggiungere 
un'immagine fissa a un logo da visualizzare su ogni carta.

M

Modello
I modelli di carta forniti da Evolis sono disponibili nella raccolta di carte. I modelli comprendono 
uno sfondo e diversi oggetti modificabili e personalizzabili dall'utente.
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R

riga
Ogni riga della tabella dei dati contiene i dati per una sola carta. Ogni nuova riga aggiunta alla 
tabella dei dati aggiunge una carta corrispondente al set di carte.

T

tabella dei dati
La tabella dei dati contiene e gestisce i dati che possono essere rappresentati sulle carte del 
documento.  È organizzata in colonne e righe.

V

valore
Un valore corrisponde ai dati specifici di una singola cella della tabella dei dati.

variabile
Gli elementi variabili di un modello di carta (contrariamente agli elementi fissi) possono essere 
modificati da una carta all'altra e possono anche essere omessi da alcune carte. Ad esempio, 
un'immagine variabile può rappresentare gli eventuali allergeni contenuti in un prodotto.
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